2015/16
Jerome Foundation
Fellowships for Emerging Artists

Fellowship Overview

This program, administered by the Minneapolis College of Art and Design (MCAD), is made possible by the generous support of the Jerome Foundation. The goal of this fellowship program is to significantly advance, artistically and critically, emerging visual artists in Minnesota.

Artists considered for this fellowship may work in a variety of visual art media, including both traditional and new media. There is no exact and singular definition of an emerging creative artist. The Foundation seeks to support those artists who show significant potential yet are under-recognized. Career stage is a factor but not a limiting one. Many emerging artists fall in the early career category but not all do. Age is not a factor in determining an emerging artist. The Jerome Foundation welcomes applications from artists representing diverse cultural perspectives.

An independent jury of three arts professionals competitively awards $12,000 grants to five artists. Fellowships may be used to purchase materials, cover production costs of artwork, and to supplement living or travel costs. Awards are subject to state and federal income tax guidelines. Over the twelve-month fellowship year, the artists will receive three studio visits from professional critics, an exhibition at the MCAD Gallery, a catalog with a critical essay on each artist’s work, and the opportunity to partake in a public panel discussion.

About the Jerome Foundation

The Jerome Foundation, created by artist and philanthropist Jerome Hill (1905–1972), seeks to contribute to a dynamic and evolving culture by supporting the creation, development, and production of new works by emerging artists. The Foundation makes grants to nonprofit arts organizations and artists in Minnesota and New York City.
Application Deadline:

Friday, September 18, 2015 at 12 p.m. (noon) CT

We only accept online applications. To begin you will need to create a new account even if you have applied for this fellowship before. Once you have created a new account you will be able to fill out the application forms and upload your images, artist statement, and résumé.

You can return to the application site and access your account by logging in at the right side of the application site. You may do this as many times as you like until you complete your submission. Once you hit "submit," you will no longer be able to log in and make any changes to your submission.

Questions?
You are welcome to attend a Jerome Information Session with Program Director Kerry Morgan or Fellowship Coordinator Nathan Lewis. A video recording of an information session will be available online after August 10.

Thursday, July 30, 6:30 p.m.
Minneapolis College of Art & Design
2501 Stevens Ave., Minneapolis
Auditorium 140

Wednesday, August 5, 6:30 p.m.
Jerome Foundation
400 Sibley Street, Suite 125, St. Paul

Thursday, August 20, 6:30 p.m.
Intermedia Arts
2822 Lyndale Avenue South, Minneapolis

Applicants are also welcome to schedule one-on-one meetings (in person or over the phone) with the program director or fellowship coordinator before submitting their applications online. To schedule a meeting please call (612) 874-3667.

For further information, contact:
Kerry Morgan, Program Director
(612) 874-3667
gallery@mcad.edu

Nathan Lewis, Fellowship Coordinator
(612) 874-3803
gallery@mcad.edu
Application Process

All applications must be submitted online through a password-secured web site.

Application Deadline:

Friday, September 18, 2015, 12:00 p.m. (noon) CT

You will not be able to upload files after 12:00 p.m. CT on September 18, 2015. Please format and upload your files a week or more in advance to ensure your system is compatible and your application will be received.

Fellowships will be announced no later than November 23, 2015. Please do not call for results.

Selection:

Three jurors, one who is familiar with the visual arts in Minnesota and two who are not, select the fellows. These panelists are artists, curators, art critics, and educators with an appreciation for and knowledge of a wide spectrum of contemporary art practices. Panelists, insofar as possible, represent a diversity of age, ethnicity, gender, and geography.

The panelists remain anonymous during the selection process. The names are revealed once the fellowship recipients are announced.

*MCAD fellowship staff does not participate in any part of the selection process.*

Process:

**Review Process:** Applicants are evaluated and selected according to these criteria: artistic excellence; evidence of serious commitment to their practice; and the impact the fellowship will have on the artist. The panel will also be asked to consider the breadth of artistic practice among Minnesota artists, which can include a wide range of aesthetics and traditions that might be influenced by ethnicity, gender, and/or geography.

**First Round:** The jurors review all submissions in the form of digital images viewed on their personal computer monitors. They are asked to score each applicant 1 to 5. Their decisions are tabulated and the top 30-40 applicants with the highest numerical score move on to the next semifinal round.

**Second Round:** The jurors are asked review for a second time the applications of the semifinalists and provide some written comments. Then a conference call is held where the panelists discuss these top 30-40 applicants. Those 10-12 applicants receiving the greatest interest will be contacted to schedule studio visits.
Email notification will be sent to all applicants on Friday, October 23. One email will be sent to applicants who did not make it to the second round. A separate email will be sent to applicants who were semifinalists, letting them know that applicants making it to the second and final rounds can contact the Program Office to set up a time to discuss the jurors’ comments. These phone conversations will happen after the announcement of the five Fellows (i.e., after Monday, November 23.)

Studio Visits for Finalists: In this final phase, the Program Office notifies the 10-12 artists identified for final review no later than Friday, October 23. Appointments are made for brief, 20-minute studio interviews with the jury. The dates for the studio visits will be November 7 and 8. The Program Director will help any finalists whose studio is outside the Twin Cities locate a space to present their work to the jury.

Notification: Upon completion of the studio visits, the Program Director will call the five Fellows and email the other finalists of the results. The Program Office will notify all applicants about the juror’s final decision via email no later than Monday, November 23. Please do not call for results.

Eligibility

Please read carefully. Applicants who do not meet all of the following criteria and expectations will not be considered and should not apply.

1. Your work must fall within current visual art practice. Artists considered for this Fellowship may work in a variety of visual art media, including both traditional and new media. The Fellowship is not intended for commercial artists, musicians, theatre artists, or others whose work is generally not presented in a visual art/gallery context.
2. You must be a resident of Minnesota, as determined by voting and/or payment of taxes in the state. Applicant must also have a street mailing address within Minnesota to be eligible to apply.
3. You must have lived in the state for at least one year prior to the application deadline.
4. You must reside in the state until the end of the 12-month Fellowship period.
5. You must be able to provide evidence that you are an emerging artist. Your resume will demonstrate limited, but promising, exhibition exposure and no more than a few grants or fellowships in direct support of your work.
6. If you live outside the Twin Cities metropolitan area and receive a MCAD/Jerome Foundation Fellowship, you must be willing to travel to the Twin Cities for Fellowship events, meetings with visiting critics and other group meetings. Documentation of artwork or delivery for review will be at the Fellow’s expense.
7. You must be willing to meet with visiting critics during the Fellowship period and accommodate your schedule to the critics' visits. This may include arranging for and transporting your artwork to a location in the Twin Cities for studio visits.
8. You must be willing to participate in a Fellowship exhibition and related activities.
9. You may not be enrolled in a degree-seeking program, either part-time or full-time, at an institution of higher learning at the time of the application deadline or during the Fellowship year.
10. You are eligible to receive this Fellowship once every three years; however, if you are a prior recipient that fact will be taken into consideration when your application is reviewed.

Applying as a Collaborative Team
While the Jerome Foundation Fellowship is traditionally awarded to single artists, we recognize that there are many contemporary artists who work as collaborative teams. If you are applying as a collaborative, make sure each artist involved meets the eligibility requirements. The images you submit should be of work created by the collaborative, not by the artists individually. However, the résumé submitted should be one file including both the collaboration’s exhibition history, as well as each artist’s. Please do not use your names, rather, distinguish between the three résumés by using the titles, “Artists A and B,” “Artist A,” and “Artist B.” In your statement, you should address why collaboration is integral to your work. Since the Fellowship is intended to further the existing practice of emerging artists, it should be clear that your collaboration is already an established part of your work.

Requirements
All applications must include the following:

Ten (10) work samples in the sequence you prefer
You must provide documentation of ten work samples as digital image files. You may choose to include full and detail shots, but each file counts as one of the ten total images, so please do not submit composite images. Do not display your name anywhere on the image (though signatures on the artworks themselves are permissible). Each juror reviews applications individually, one image at a time, on computer monitors.

Image files should be saved in JPEG format (the filename will end with .jpg) at 72 ppi and 1920 pixels at the longest side (the square format from last year has been changed.) This is the standard format for online calls for entry such as CaFÉ (callforentry.org). Please see the Image Formatting section to learn how to properly format your images to these specifications.

You will be asked to provide the following information for each work sample submitted: the title of the work; medium or media; dimensions of the actual image or object; and its date (year) of creation. You can also add a brief 300-character annotation describing the medium, context, or installation of a particular work.

Video options. You may submit up to two video links from YouTube to the application site. To use YouTube, you will need to register for a free account. For information about how to do this, please go to: youtube.com. Each video should not be more than three (3) minutes in length.

Video submissions should supplement, not replace or extend, the ten still images. Therefore, any video, kinetic, or time-based work referenced in a multimedia installation must be indicated by at least one still image in the sequence of ten. Because of the blind jury process ideally there should be no voiceover narration, artist appearance or name included in the video submission,
but those are permissible if they are integral to the piece. Applicability of video submissions will be subject to review by the Program Office; documentation of additional works not included in your ten still images will result in the video being removed from your application.

Résumé and artist statement

Submit a current résumé (any length) and a single-page artist statement about your work. Your artist statement should mention what you will be working on in the upcoming year. Examples of professional artist résumés are available at the College Art Association website: collegeart.org/guidelines/resume. Please do not include your name or contact information on the résumé or artist statement. Your résumé and artist statement should be saved as Microsoft Word documents (the filename will end with .doc), Plain Text Files (.txt), or Rich Text Format documents (.rtf)

Incomplete files will not be reviewed.

Image Formatting

Saving your Image as a JPEG:

If your image is saved in a format other than JPEG (.tiff, .psd, .pict, etc.) it will not work. You can save your image as a .jpg in multiple ways. In Photoshop and most other image editing programs, you can go to File > Save for Web and Devices in the menu. Notice the box that allows you to set quality. In general, a higher quality setting (70-90) is better, so long as the size is less than 1.8MB (it should be significantly less). Be sure that "sRGB" is checked on, and that you save as a Jpeg, not a gif.

Preparing and Resizing Images: Overview

To resize your image so that it conforms to the 1920 at the longest dimension protocol you will need photo-editing software that can resize images, change image resolution, create new images, and save images as JPEGs. The steps will vary depending on the photo editing program you are using; see Resources section for photo-editing software options. Below are generalized instructions for Photoshop:

Photoshop Tips

1. If possible, it is best to start out with an original uncompressed image file that has been prepped and is at minimum no less than 27 inches or 1920 pixels after cropping, adjusting contrast, adjusting color, sharpen, etc. Nearly all cameras will produce images much larger than 1920@72ppi, so this should not be an issue.
2. You will be adjusting these files to meet the image specification size by following the steps below.
3. Open the file in Adobe Photoshop.
4. Go to Image - Image Size to open the Image Size dialogue box.
5. Set Resolution to 72 ppi (pixels per inch); Uncheck “Resample Image,” before you change the
resolution. Afterwards, recheck “Resample Image.”

6. Identify the longest dimension (make sure “Constrain Proportions” is checked) and set it to 1920 pixels. This will generally be a reduction in size.

7. Click OK.

8. Save for Web – Go to File - Save for Web and other Devices to open the Save for Web dialogue box.

9. Make sure the setting is JPEG.

10. Quality should be between 70-90.

11. Click Save.

12. Make sure sRGB is checked.

13. Save Optimized image as JPEG in a folder that is easy to find on your computer.

14. Name it something easy to remember, like jeromeimage1.jpg.

15. Click Save (leave all other options as is, i.e., format, settings, etc.)

16. You are now done with the first image. Now repeat these steps for the rest of the images you plan to upload to your application.

17. Remember, save it as a JPEG file format. Name the file correctly including the .jpg file extension.

Don’t wait until the last minute! If everyone is trying to upload his/her application at 11:55 a.m. on the application deadline date, the system may not be able to accommodate all of the uploading. Please plan ahead and give yourself time in case something goes wrong.

Image Format

The only file type that will upload is the JPEG file format, with a file name that ends in the .jpg file extension. Files should be in sRGB color mode, not CYMK, which will not display correctly on screen.

Large Images

Although our system will accept larger image files, it does have limits. Larger images will also take longer to upload. If you correctly size your files and save at a moderately high level of quality, you should have more success. Images should not be larger than 1.8 MB.

Connection Errors

There may be certain times of day when uploading an image works better than others. You may notice a difference in upload times between images of the same size. This variability comes from the nature of the Internet, and may be due to one or more of several factors, including:

1. Bandwidth: Several applicants trying to upload images at the same time, or overall heavy internet traffic can make things slow - try uploading again at a different time.

2. Connection: A bad connection between your phone, wireless, cable, or network and your ISP (internet service provider) may be the problem - by disconnecting and reconnecting to
the internet, you may be able to establish a better connection.

3. Firewall software or Proxy server: If you are using a firewall program like Zone Alarm or Norton System Works, you may want to turn off the software while you are uploading.

4. Memory: Restarting your computer and clearing your browser's memory cache will free up memory and may speed things up. It's also a good idea to quit from other applications before uploading, since these use up available memory as well.

**Video Uploading on YouTube**

The information you need to upload to YouTube will be found on their website: youtube.com. We prefer to use YouTube as our webmaster is able to create an interface that edits out your name completely. That function is not possible using Vimeo.

To get started uploading videos on YouTube, follow the steps below:

1. Sign into YouTube (or create an account).
2. Click the Upload link at the top of the page.
3. Select the video you'd like to upload from your computer.

Once the upload is completed YouTube will send you an email to notify you that your video is done uploading and processing.

**Digital Files**

**What is a JPEG (.jpg)?**

A JPEG is a digital image format for on-screen viewing. JPEGs allow file sizes to be very small without much loss in quality. The Windows suffix for a JPEG is .jpg. JPEGs support over 16 million colors, but slightly "distort" the image to compress the file size. For most photos, the human eye cannot tell the subtle changes in color, but along straight edges and in pictures with large solid colors, distortion can become very apparent.

When you save a file as a JPEG, you will be offered a choice between different levels of compression. You may want to test different levels before uploading your files to maximize quality while uploading the smallest files size possible (which takes less time). Where this setting is located varies with different image software, but most have a 1-100 quality setting that you can set (some use 0-10 or 0-12). Higher quality means less distortion but larger files. It is important to find a balance between the two remembering that files under 500 KB seem to work best.

If you are using Photoshop, you should use the "Save for Web..." option from the "File" menu. This feature further reduces the file size by omitting the thumbnail and preview from the .jpg file, which are not used on the web. When using the "Save for Web..." option, be sure to choose JPEG for the compression format.

Also make sure to save all files in RGB color mode, as CMYK will not display correctly for the jury.

Please note: Since a JPEG is a compressed file it will re-compress each time you save it. This will cause repeated reductions in file size and ultimately degrade the quality of the image. You
should save your images as Photoshop (.psd) or TIFF (.tiff) files while you are working on them and then save them as JPEGs when you are ready to upload.

**How does resolution/image size work in a digital image?**
A digital image is made of pixels, little pieces of visual information that are square and uniform in size. When a scanner digitizes a print, slide, or negative, it acts like a digital camera converting the image into pixels.

Resolution is measured for digital images by the number of pixels in each square inch of the image, ppi (pixels per inch). Fewer ppi (a lower resolution) makes each pixel larger, revealing to the eye that the image is made up of little squares (the ugly effect called "pixilation"). More ppi - a higher resolution - reduces the size of each pixel, and the image will look sharper. High-resolution images are required for enlarging the image onscreen or printing the file. Images with a lower resolution, like those on Internet sites, are better suited for viewing on a computer monitor, which has a set number of pixels per inch (72 ppi) that it can display.

When you work with a digital image, you have the option to change the size of the image and the resolution. These settings will appear in the "Image Size" dialog box available from the "Image" menu in Adobe Photoshop. You also have the option of setting these parameters when you use a scanner or a digital camera. It is easy to reduce the size and resolution of an image without drastically reducing its apparent quality. Even an extremely low-resolution image will look fine if it is very small, because the number of pixels per inch will meet or exceed the resolution of the display. Things get ugly when you try to enlarge the image beyond the limits of its original resolution.

Shoot or scan your original image at a higher resolution and/or a larger size than the final output requirements. You can reduce your final image to the size and resolution required - 1920 pixels at the longest side with 72 pixels per inch. Standardizing submissions at that size and resolution guarantees that we will not need to adjust your image.

**Why are you measuring in “ppi?” Isn’t it “dpi?”**
Dots per inch (dpi) are a measure of image resolution used for printing. It's the number of dots of ink the printer drops on each square inch of paper. Your application will be viewed on a computer screen, where resolution is measured in pixels.

**Are the jurors’ computers properly calibrated for color?**
While there is no way to guarantee that the color settings on the jury's computers will exactly match yours, we will instruct the jurors to view your images on a monitor calibrated to Adobe (1998) RGB, which is the current standard. This will ensure a nearly uniform color as possible. If there are color effects vital to your work that you feel are lost in translation to a digital image, point them out in your annotated image list.

**How should I go about creating and saving digital images of my work?**
You have many options. It is possible to engage the services of a professional for any part of preparing the images, and you can learn to do any part for yourself. Before you start, consult a good book on digital photography and imaging. If you have access to a high quality (5 megapixel or higher) digital camera, this may be a good option. Unless you are comfortable and familiar with the process of taking professional-quality digital images, you should consider having this
done professionally. Many photographers, studios and photo-service providers shoot digitally now; with a little research you should be able to find one nearby.

Then you will need to edit and format your images. How you do this depends on how comfortable you are working with computers and digital images.

Some photo-service providers will be able to correct and size your images and burn them to a CD. Others may only be able to give you the raw digital files, requiring you to size and save them on your home computer or somewhere else, like Kinko's or a local computing center. You will need to research your options, which will vary depending on where you live, how tech-savvy you are, and how much you are willing to spend.

One of the advantages of computer technology is that there are many ways to get access to the technologies you need. Most professional photo services will be able to do most or all of the work of digitizing your images. Many public libraries have computers available for public use. Public agencies and community organizations often offer computer services. Service providers like Kinko's or a local Internet cafe offer varying levels of technology access and support.

What type of software will I need for my images, résumé and statement?
To size and save your images, you will need use a computer equipped with a recent version of Adobe Photoshop, or another imaging program like Corel Paint Shop Pro or Microsoft Digital Image Suite.

For the résumé and artist statement, you will need Microsoft Word, or another word-processing program that can save a SimpleText (.txt) or Rich Text (.rtf) file, like ClarisWorks, WordPerfect, TextEdit, or Adobe Acrobat Pro. Your résumé and artist statement should be 500 KB or smaller.

When you apply online, you will create the image list by entering text into fields when you upload your images.
Resources

Books:
Numerous books and articles are available on the subject of digital photography and imaging. A trip to the local bookstore or camera shop, a visit to amazon.com, or an Internet search for something like "take good digital photographs" or "scanning slides" should turn up plenty of information sources.

We've found that Digital Photography: An Introduction by Tom Ang is a helpful guide to the basics of the medium. Chapters 3 and 4 are especially helpful for turning your existing images into digital files. It retails for about $15.

Photo Services:
FedEx Kinko's
Probably the most widespread and one-stop option, these stores have computers with Adobe Photoshop and Microsoft Word, can scan your slides or photographs and burn CDs. Visit www.fedex.com to find the location nearest you.

DigiGraphics
Located in Minneapolis, DigiGraphics is a full-service professional photo service.
2639 Minnehaha Ave., Minneapolis, MN 55406
Visit online at www.digidigi.com.

ProEx
In the Twin Cities and Rochester, ProEx can scan your slides or photographs and burn them to CD, but they can't edit or size them.
You can visit www.proex.com to find a nearby location.

Digital Imaging Software:
There are a variety of products that can help you format your images successfully. Packaged software is available to purchase as well as free downloadable software. Recently various websites are offering online image editing tools as well.

Adobe (http://www.adobe.com) currently provides two photo editing products--Adobe Photoshop and Adobe Elements--that are very popular among today's designers and artists. Adobe Elements, the less-expensive option, provides a free 30-day trial if you would like to try the program before purchasing.

Get Paint (http://www.getpaint.net), a free open-source program for Windows-based computers, can also help to format images successfully. If you are a Mac user, download Gimp (http://www.gimp.org), a useful image-editing program.

Sumo (http://www.sumopaint.com/web/), Aviary (http://aviary.com/home), and Pixlr (http://www.pixlr.com/) are some of the few websites out there that offer image-editing right in the browser.
**Arts Advocacy Organizations:**

**MNartists.org**
MNartists.org offers some "how-to" help with digitizing images. Their website has a list of technology resources and Arts Advocacy organizations. They periodically run workshops on digitizing images and uploading them to the Internet.
www.mnartists.org

**IFP MN**
IFP MN provides free scanner access for mnartists.org artists. They also rent film, photo and editing equipment to members. Call for an appointment.
550 Vandalia St #120, St Paul, MN 55114
(651) 644-1912
www.ifpmn.org

**Springboard for the Arts**
Springboard is a Twin-Cities based arts-advocacy organization that offers workshops, professional consultations and some technology services to working artists. Some services are free; you will have to pay for others.
308 Prince Street, Suite 270, St. Paul, MN 55101
651-292-4381
www.springboardforthearts.org

**VSA Minnesota**
VSA Minnesota works with arts organizations throughout the state to assist them in making their programs and services accessible to people with disabilities.
The Cowles Center, 528 Hennepin Avenue, Suite # 305, Minneapolis, MN 55403
612-332-3888 (voice/TTD/TTY)
www.vsaartsmn.org

**Regional Arts Boards:**
These organizations are affiliated with the Minnesota State Arts Board and the McKnight Foundation. They may be able to offer you computer access and assistance or direct you to someone near you who can.

Kittson, Marshall, Norman, Pennington, Polk, Red Lake, and Roseau counties:
**Northwest Regional Arts Council**
115 South Main, Warren, MN 56762
218-745-6733
www.nwrdc.org/arts.htm

Beltrami, Clearwater, Hubbard, Lake of the Woods, and Mahnomen counties:
**Region 2 Arts Council**
426 Bemidji Ave., Bemidji, MN 56601
800-275-5447
www.r2arts.org

Aitkin, Carlton, Cook, Itasca, Koochiching, Lake, and Saint Louis counties:
Arrowhead Regional Arts Council
1301 Rice Lake Road, Suite 111, Duluth, MN 55811
800-569-8134
www.aracouncil.org

Becker, Clay, Douglas, Grant, Otter Tail, Pope, Stevens, Traverse, and Wilkin counties:
Lake Region Arts Council
133 South Mill Street, Fergus Falls, MN 56537
800-262-2787
www.lrac4.org

Cass, Crow Wing, Morrison, Todd, and Wadena counties:
Five Wings Arts Council
200 First Street NE, Staples, MN 56479
218-894-5485
www.fwac.org

Big Stone, Chippewa, Cottonwood, Jackson, Kandiyohi, Lincoln, Lac qui Parle, Lyon,
McLeod, Meeker, Murray, Nobles, Pipestone, Redwood, Renville, Rock, Swift, and
Yellow Medicine Counties:
Southwest Minnesota Arts & Humanities Council
1210 East College Drive, Suite 600, Marshall, MN 56258
800-622-5284
www.smahc.org

Chisago, Isanti, Kanabec, Mille Lacs, and Pine counties:
East Central Arts Council
100 Park Street South, Mora, MN 55051
320-679-4065 ext. 30
www.region7erdc.org

Benton, Sherburne, Stearns, and Wright counties:
Central Minnesota Arts Board
114 Fourth Avenue North, Foley, MN 56329
866-345-7140
www.centralmnartsboard.org

Blue Earth, Brown, Faribault, Le Sueur, Martin, Nicollet, Sibley, Waseca, and Watonwan counties:
Prairie Lakes Regional Arts Council
111 2nd Avenue NE, Waseca, MN 56093
800-298-1254
www.plrac.org
Dodge, Fillmore, Freeborn, Goodhue, Houston, Olmsted, Mower, Rice, Steele, Wabasha, and Winona counties:
Southeastern Minnesota Arts Council
1610 14th Street NW, Rochester, MN 55901
507-281-4848
www.semac.org

Anoka, Carver, Dakota, Hennepin, Ramsey, Scott, and Washington counties:
Metropolitan Regional Arts Council
2324 University Avenue West, Suite 114, St. Paul, MN 55114
651-645-0402
www.mrac.org

For software help:

About.com
www.about.com is a searchable online database of information on many subjects. Try searching "digital photography" or "scanning."
www.about.com

TutorGig
This is a searchable online database of software tutorials.
www.tutorgig.com

Adobe Support
Adobe.com has tutorials and troubleshooting advice for Photoshop users.
www.adobe.com/support/photoshop/

Microsoft Support
If you're having trouble with Microsoft Word, perhaps Microsoft Support can help.
support.microsoft.com